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B.1 Troubleshooting

Main Menu Function

NFIP Import

Problem — The NFIP import process begins, but “hangs” before it is finished.

Solution — This is generally a computer processing issue related to the speed and
memory specifications of the PC. See System Requirements in
Appendix A for suggested PC configuration and try importing smaller
portions of data (fewer records) if necessary.

Problem — After choosing a file for import, there is an error message, “The
Following error has occurred: -2147418113 - Catastrophic
failure.”

Solution — Make sure you have the correct drill down. There are drill downs with
similar but not identical formats to the one used with the tool — the RL
Data for National Tool. Be sure the drilldown being used is in the
correct format and refer to Section 4.6.1, Downloading NFIP Data, on
how to access this data.

Problem — When importing NFIP data for updates of existing records, the
older data are not being replaced with data from the new import.
Instead, new records are created.

Solution — Make sure that the Property Locator/Rep Loss number on the record
matches the one in the NFIP spreadsheet.

Appending Data

Problem — | appended data more than once from the same database. Some of
my image names have changed to include *“_01” or “_02” and the
disk space used has increased dramatically.

Solution — When you append data into the database, it also appends the images
into the NFMDCT folder where your database resides. During the
append process you can select how duplicate images are handled. If
you selected to Not overwrite files with the same name, then the file
was renamed with a sequential number. This doubles up the amount
of disk space used and isn’t very efficient.
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To correct the situation, you can use one of these two options.

1. Manually remove the extra images by deleting them from each property
record.

2. Create a new database and append the data only one time. If there are a lot
of renamed images, this may be less time-consuming than Option 1. To
create a new database, copy the empty NFMDCT database from the
appropriate folder on the installation CD. Append the data from the
original database only one time into the empty database.

Problem — I appended data from a previous version of the NT and the “Total
Number of Claims per NFIP” field on the Insurance screen
contains “Unknown.”

Solution — This occurs because this field did not exist in the older versions of the
NT. To fix the problem, re-import the latest NFIP data.

Images

Problem — TIF images are not loading on the image screen or being displayed
as a thumbnail.

Solution — Microsoft Office 2003 does not include TIF graphics filter files which
are necessary for proper viewing of TIFs in this application. You can
load the necessary files from installation CDs for previous versions of
OFFICE (XP). To load the files, load the Microsoft Office CD into
the PC and choose Custom Installation. Load the Graphics Filters
found under Office Shared Features, Converters, and Filters. Make
sure to click on all other entries and apply the “X” so the older
applications are not installed.

PDF Documents

Problem — When clicking on a PDF document link, my screen flashes and the
document never displays.

Solution — PDF documents are located throughout the NT application, but reside
mostly on the HELP screen. Adobe Reader 7.0 has a known bug
where it won’t display PDF documents when they are linked from a
Microsoft Office document. If you have Adobe Reader 7.0, uninstall
it and download the latest version of Adobe Reader from the Adobe
web site (http://www.adobe.com).
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Problem — When clicking on a PDF document link, | receive the error
“Unable to open ...PDF. No program is registered to open this
file.”

Solution — Several of the supporting documents for the NT are PDFs (Portable
Document Format). These documents need Adobe Acrobat Reader in
order to open them. You can download Adobe Reader from the
Adobe web site (http://www.adobe.com). Please note the Adobe
Reader 7.0 issue in the preceding problem and solution.

Problem — I could not print to PDF.

Solution — During the NT installation, two additional files will be installed called
DynaPDF.dIl and StrStorage.dll into the same folder as the database.
Check the location of these files. These are necessary in order to print
to PDF. If you move the database and not the files, you won’t be able
to print to PDF without a PDF printer.

Miscellaneous

Problem — My database continues to grow in size. Can it be compacted?

Solution — Yes. Microsoft Access databases do not recover unused space until
they are compacted. As with all Microsoft Access databases, it will
need to be compacted periodically. Access has a built in feature to
compact automatically every time the database is closed. However,
this feature is not included in the NT program because of the time
delay and risk of corruption. If the compact process is interrupted,
the database will be corrupted. Therefore, compacting is a process
that must be performed manually.

There are two ways you can compact:
e Through the use of the Compact_ MDB program in NT

e Through Microsoft Access

Compacting using the Compact MDB program in NT

1. Locate the Compact_MDB.exe file on the NT Installation CD
and copy it to the same location as the master database.

2. Double-click the filename to execute.

3. Click “Browse” to locate the database to be compacted, then
press OK.

User’s Guide B-3 2011



National Flood Mitigation Data Collection Tool and RLP Viewer Appendix B

4. An ***Important*** information box is displayed (as shown at

upper right). The database will be backed up into a new folder
called “Backup.” Do not interrupt the compact process once it
has started. If it is interrupted, the database will be corrupted.
If that happens, you can restore it from the backup folder
located where the database resides.

5. Click “Yes” to continue and the database will be compacted.

When completed, a message will be displayed.

6. The database is now compacted. A backup is captured for you

in the Backup folder. As other compactions are done, the
backups will be numbered sequentially in the Backup folder.

Compacting through Microsoft Access 2002 or 2003

. Open Microsoft Access.
. On the toolbar, select Tools / Database Utilities / Compact and

Repair Database menu item.

. You are prompted for the “Database to Compact From” file.

Browse to and select the master database and press Compact.

. You are then prompted for the “Compact Database Into”

filename. Enter a new filename (example:
NFMDCT_RegionlV_Master_Compacted.mdb) and press Save.
The compacting process will begin.

. When the compacting process is finished, exit Microsoft

Access.

. Rename the old master database to something more meaningful

(example: NFMDCT_RegionlVV_Master_Backupl.mdb).

. Rename the compacted database to the original name

(NFMDCT_RegionlV_Master.mdb).

Compacting through Microsoft Access 2007

1. Open Microsoft Access 2007.
2. Click on the Office button in the top left corner of the screen.
3. Click Manage on the left, then Compact and Repair Database.

4. You are prompted for the “Database to Compact From” file.

Browse to and select the master database and press Compact.
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You are then prompted for the “Compact Database Into”
filename. Enter a new filename (example:

NFMDCT _RegionlV_Master_Compacted.mdb) and press Save.
The compacting process will begin.

5. When the compacting process is finished, exit Microsoft
Access.

6. Rename the old master database to something more meaningful
(example: NFMDCT_RegionlVV_Master_Backupl.mdb).

7. Rename the compacted database to the original name
(NFMDCT_RegionlV_Master.mdb).
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B.2 FAQs

Q: How do | create a smaller database with specific properties?

A: Create a subset NT database (Section 4.6.7).

Q: How do | combine several community databases into one main county database?
A: Append properties (Section 4.6.4).

Q: How do | create a spreadsheet with selected properties so | can update
information in a single category all at once?

A: There are two ways: 1) From Limited or Detailed Views, use Find
Properties to select the properties you want, and then select Export
Property Data Template from the Tools Menu. 2) From the Main Menu,
select Utilities, then Export Property Data Template. Delete the rows for
properties you don’t want to import.

Q: I exported the Claims and Flood Events spreadsheet and updated it. Why can’t |
import it into NT?

A: This spreadsheet cannot be imported into NT. The data from this
spreadsheet is for use with FEMA’s Benefit Cost Analysis (BCA)
program. To add updated Claims or Flood Events data, update the data
fields in the Property Data Template spreadsheet under the appropriate
worksheet tab and then import the Property Data Template into NT to add
the information.

Q: | need to have the same photo associated with several different properties. Should
I rename the photo file each time | want to add it to a different property before
importing?

A: You can go into the Photo Gallery, locate the image, right click it and
assign it to additional properties. Alternatively, in the property data
template spreadsheet, enter the same document path and file name of the
photo for each property you want. The photo will be imported once, but
NT will associate it with all of the different properties. Same reasoning
works for the same document associated with several different properties
(Section 4.6.3).

Q: | entered all of my field information into a property and then later found out that it
is the duplicate of another property. Do | have to retype all of the same
information into the main property?

A: No, you can merge properties (Section 4.6.5).

Q: Why did | receive an error after trying to import several photos? | included the

entire path.

A: Make sure the filenames of your photos do not have any blank spaces. If
they do, either replace the spaces with an underscore (“_") or remove the
spaces entirely.
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B.3 Importing Property Data into the NT

Many data fields for multiple properties can be imported at one time by populating a
Property Data Template (a Microsoft Excel spreadsheet) with the Property Locator/Rep
Loss Number and a column for each data field found in NT. Any errors during the import
process are displayed in a report immediately following the import.

Steps for Importing Property Data (with notes for each step)

1. Export the property data template.
e The template is run from the Utilities Menu or from the Tools menu in any of
the data views.

e The template is a Microsoft Excel spreadsheet containing a column for each
data field that can be imported.

e The property data for each property are also exported.
e Some of the columns limit your entries by using drop down lists.

e Templates are available for each data view as well as Claims and Flood
Events.

e You can limit the properties exported by using the Find Properties feature in
the each of the data views.

2. Populate the spreadsheet with the values to be imported.
e Delete or hide the columns you don’t want to import. It won’t hurt to keep a
column with empty values.
e Delete or hide rows for properties you don’t need to import.

e Delete worksheets you will not be using to import data.

e The Property Locator/Rep Loss Num column is required and must exist in the
spreadsheet. The number does not have to contain the leading zeros.

e Do NOT rename any of the column names. If you do, the import process will
fail for that column.

e If you enter inspector information, make sure to enter the inspection date. If
you don’t, the inspection information will not be imported.

e Claims and flood events will also not import without the date.
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You can import multiple image and document files for a property by
separating the filenames with a comma or a semi-colon (e.g.,
¢:/RL0O0001899 1.jpg, c:/RLO0001899 2.jpg, etc.). Do not mix commas and
semi-colons as a file separator in the same cell. Also, do not include blank
spaces in the filename. Replace blank spaces with an underscore (“_) or

hyphen (*-).

If multiple properties share the same image or document file, enter the same
document path and filename for each property in the spreadsheet. The file
will only be moved once, but it will be associated with each property it was
assigned to.

Note: This same process applies to existing image or document files in the
database. That is, if you are importing a file that has already been imported
for another property, the file will not be moved (if your path is the NFMDCT
folder). However, an association will be made between the new property and
the existing file. The image or document file can then be viewed in both
property records.

3. Import the data.

Open the NT database, go to the Utilities menu, and select Import the
Property Data Template. Browse to locate and select the spreadsheet, and
then press Import to continue.

If any warnings or errors are detected in the import process, a Property Data
Import Warnings and Errors report will be generated to provide more detailed
information about the errors. The following table lists possible warnings and
errors included on the Property Data Import Warnings and Errors report with
their solutions.

Possible Warnings, Errors, and Solutions

Warning/Error Solution

The Property Locator/Rep Loss Num | The Property Locator/Rep Loss Num column is
column was not found in the required. Make sure the column exists and the
spreadsheet. spelling of the column name is correct.

Invalid Column. Not imported. The column name is not recognized as a valid

column. Check the spelling of the column name
against the template columns and/or export the
data template and copy the column name.

Text data too long. Only n chars The column data value for this row contains too
allowed.

many characters. Itis limited to the number of
characters given.
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Warning/Error

Solution

Invalid Date.

The column data value for this row does not
contain a date in valid date format. Format the
column as a date field (mm/dd/yyyy).

Invalid value. Must match a value in
the drop-down box.

The data value for this column does not match a
valid value from the drop down box in the NT.
Check the NT screen drop down box for this field
for valid values or print the drop down box values
from the Help menu.

File doesn't exist in the path stated.

The image/document doesn’t exist in the path
stated. Check the spelling and location of the
image/document path. If both commas and
semi-colons were used in the same cell to
separate multiple image/document names,
change to only one type of separator. You
cannot use both commas and semi-colons in the
same cell when separating filenames.

Number too large. Must be <
999,999,999.

The number value is too large. Make sure it is
less than the number listed.

Invalid value. Valid Values are: X, X,
X.

The value entered is invalid. Select one of the
values listed.

Inspection must contain an
inspection date. Not imported.

The inspection date is missing for this row. The
inspection record won't be imported unless it has
a valid inspection date. Enter the inspection
date in the format mm/dd/yyyy.

Warning: Image/Document already
exists for property: n. This property
will be assigned to the existing
Image/Document.

The image/document being imported already
exists in the NFMDCT folder; therefore, this
image/document was not imported. The
imported property was assigned to the existing
image/document.

If the imported property shouldn’t be assigned to
the existing image/document, you can un-assign
it by going to the View > Images or Documents
menu and deleting the image/document. The
image/document will not be permanently deleted
from NT until it is deleted from the last property
assigned to it.

If the image/document name is not spelled
correctly, change it before re-importing.
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Warning/Error

Solution

Warning: Image/Document already
existed in the NFMDCT folder, but it
was not assigned to any properties.
The existing Image/Document was
overwritten with the new

The image/document being imported already
existed in the NFMDCT folder, but there were no
properties assigned to the image/document.
This may occur when images/documents are
manipulated outside of the NT database.

Image/Document.
Since the image/document wasn’t assigned to a
property, the new image/document replaced the
existing image/document.
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